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♣What Is A Personal Computer (PCs)? 
A personal computer is a stand-alone computer that is equipped with a central processing 
unit (CPU), one or more disk drives, random access memory (RAM), a monitor, a 
keyboard, and a mouse.  
It comes in an assortment of shapes and sizes.  
A personal computer is a device that allows you to do a lot of work in a very short 
amount of time. It allows you to communicate with businesses, friends, family and 
strangers around the world. It helps you organize all of your information from your 
personal address book to your checkbook.  
Your personal computer will become a teacher of new skills, games, and ideas. Your 
computer is YOUR personal assistant. 
 
♣Types Of PCs 
There are two broad categories of PCs: stay at home and portable.  
Home computers come in two basic models, desktop and tower.  
The desktop model sits horizontally on your desk while the tower model sits vertically. 
The tower model has a smaller footprint and takes up less desk space. The orientation of 
the system box is the only difference in the two computers. Due to their size, they are not 
frequently moved.  
Portable computers such as laptops and notebooks are much smaller and are easily 
transported. They are lightweight and can sit comfortably in your lap. They run on 
batteries and connect to household electricity. 
 
♣What Is Hardware? 
Hardware is a term for the physical components that are included when you purchase a 
PC. They include the system box, monitor, keyboard and mouse.  
You can purchase additional hardware items such as modems, scanners CD-ROM drives, 
DVD drives, video cameras. 
By itself, hardware is not capable of doing anything. Look at your stereo. It sits there 
looking nice, without emitting sounds until the hardware pieces are given the sounds to 
play.  
Your computer needs something to make it work. That something is software. 
 
♣What Is Software?  
Software tells the hardware how to work, what to do, and when to do it.  
Software is what gives your computer its identity. It includes the basic operating system, 
utility, or application programs, all expressed in a language your hardware understands.  
There is software to tell your computer to do just about any task. Think about when you 
first balanced your checkbook. Either someone showed you how to do it or you followed 
the instructions on the back of your statement. 
Those instructions "programmed" you on how to do the task at hand: balancing your 
checkbook. Those instructions were your "software" and you were the "hardware" that 
did the work. 
 
♣What Is A "Propeller Head"? 



A propeller head is a term used for those people who create, build or have a hand in the 
development of all the computer-based technologies that we use today. 
 
♣What Are Applications? 
Software applications are programs that a computer uses so that the machine 
accomplishes predetermined tasks. 
Each application performs a specific kind of work, such as, word processing, desktop 
publishing and accounting, personal finance, etc.  
There is an application for just about any task you can think of. 
Do you want to organize your stamp collection? There's software to help you do just that. 
Do you want to design your next home? Yes, software exists for that too. 

 
♣What Is A "Utility Program "? 
A utility program is an after-market application that does housekeeping operations to 
assist you in maintaining and improving your computer's performance. 
 
♣What Is An Operating System? 
An operating system is the master control program for the computer. It is the stored 
information that your computer needs to operate.  
Without an operating system all of the hardware would just sit there and collect dust! The 
hardware is like your skeleton, muscles, and organs and Operating System is the brain! 
 
♣What Is The Central Processing Unit (CPU)? 
Sometimes we refer to the CPU as the system box or brain. It is the computer chip that 
does all of the processing for the computer.  
Inside this tiny chip are millions of transistors (electrical switches) that are connected so 
they can carry out mathematical calculations. Everything a computer does is essentially a 
mathematical calculation. 
 
♣What Is CPU Speed? 
We measure the central processing unit's (CPU) speed in megahertz (MHz). Megahertz is 
a unit of measurement commonly used to compare the speed of computers.  
The higher the CPU's megahertz rate, the faster it processes information and instructions. 
 
♣What Is Random Access Memory (RAM)? 
RAM is the computer's primary working memory.  
RAM is used for short-term storage while the computer does its work. It is read/write 
memory.  
RAM is distinguished from ROM, which is read-only memory. The more RAM you have 
the more your computer can do at one time.  
RAM is volatile memory. It needs to be running to "remember" what it is doing. In case 
of a system failure or power interruption, you will lose all of your work in RAM that you 
have not saved on a disk drive. Save your work frequently.  
Most computers these days have between 32 and 64 megabytes of RAM. 
 



♣What Is A Megabyte? 
A megabyte is a large unit of measurement of storage capacity. Here is how storage 
capacity is calculated:  

• Bit = smallest amount of info.  
• Byte = eight bits strung together.  
• Kilobyte (KB or K) = about 1000 bytes.  
• Megabyte (MB or Meg) = about a million bytes.  
• Gigabyte (GB or gig) = about a billion bytes. 

 
♣Ram Vs. Hard Drive Storage 
Storage is where the program is kept, RAM is where it works.  
The amount of space a program needs for storage on the hard drive has nothing to do 
with how much RAM is needed to run the program.  
Many PC programs take up several megabytes of storage space. Many programs also 
require at least 16MB to 32MB (or more) of RAM.  
To run today's popular programs, make sure your computer has adequate RAM and 
storage. 
 
♣What Are Disk Drives? 
Disk drives allow you to store and move data from, and to, different types of media.  
There are several types of drives: floppy drive, hard drive, CD-ROM drive, and DVD 
drive.  
 
♣How Do Drives Differ? 
The biggest difference in drives is size or capacity. Drives also differ in how fast they 
take to find and access information. 
 
♣What Is A Floppy Drive? 
A floppy disk drive is an economical, removable storage medium. It uses a magnetic 
disk. You can record or erase it and then remove it from the computer. You can use the 
removable disk repeatedly.  
Today's floppy is 3.5 inches of square, stiff plastic with a magnetic disk inside. It is called 
a floppy because the original disk, way back when, was large and floppy like a hound 
dog's ear. The term "floppy" is still with us.  
To read or write to a floppy disk, insert the disk into the floppy disk drive slot on the 
front of your system box. 
 
♣What Is The Hard Drive?  
The hard disk, or hard drive, is your PC's main storage device. It's sometimes called the 
C: / drive and pronounced "cee" drive. Data is magnetically stored there. It stores 
programs and data files.  
A typical hard disk holds from 1 to 10 gigabytes of storage. Much larger hard drive 
capacity is available. 
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♣What Is A CD-Rom Drive? 
CD-ROMs are compact discs, read-only, removable storage media. CD-ROMs read the 
data encoded on the disc and then transfer this data to the computer. 
CD-ROMs are different from hard drives and floppy disks, in that you cannot store your 
own information on them.  
One CD-ROM can hold as much information as about 450 floppy diskettes.  
 
♣What Is A Monitor? 
Sometimes we call the monitor a CRT (cathode ray tube) and sometimes we refer to it as 
a video display unit.  
The monitor attaches to the video output of the computer and produces a visual display.  
Most computers these days come with a 15-inch monitor. For an additional cost you can 
upgrade to a larger monitor. Large monitors are a dream to work with and make it much 
easier to view your work. However, they take up more space on your desk. 
 
♣What Is A QWERTY Keyboard?  
It is the standard typewriter keyboard layout, used for computer keyboards.  
It is the most frequently used input device for all computers.  
The keyboard provides a set of alphabetic, numeric, punctuation, symbol, and control 
keys. 
 
♣What Is A Mouse? 
The mouse is a control device. It controls the pointer on your computer screen.  
It is housed in a palm-sized case. When you move it on your desk, the corresponding 
arrow, commonly known as the pointer, moves on the computer screen.  
Think of it as a remote control for your computer. Move the mouse left and right, the 
pointer moves left and right. Move the mouse forward and backward, the pointer moves 
up and down the screen. Using the mouse to command the computer to do most tasks can 
eliminate many keyboard strokes.  
The flashing bar, known as the cursor, is where the work will take place on the computer 
screen. To move the cursor with the mouse, place the pointer where you want the cursor 
to appear and click the mouse. 
 
♣What Are Expansion Slots? 
A system has expansion slots so you can add additional hardware, known as peripherals 
or add-ons. Expansion cards give the computer additional capabilities. 
Some slots may already be taken for a sound card or video card.  

 
♣What Is Multimedia? 
Multimedia is a term used to describe any program that incorporates some combination 
of sound, music, written text, pictures, animation, and video. Almost all of the computers 
on the market today are multimedia capable. 
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♣What Is A Printer? 
A printer is a device designed to print computer-generated documents onto paper. 
Printers vary in their quality, speed, graphics capabilities, fonts, and even paper usage. 
There are dozens of brands of printers. The three most popular types of printers are dot 
matrix, ink jet (bubble jet), and laser printers.  

• Dot Matrix: A dot matrix printer uses a print head and a ribbon to print a 
document. These printers are inexpensive and tend to be slow and loud. Their 
print quality is fair.  

• Ink Jet (Bubble Jet): An inkjet printer works by spraying tiny dots of ink onto 
the paper. The print head controls the spray pattern to form the print. Excellent 
print quality at a reasonable price.  

• Laser: A laser printer offers great quality and fast printing. It is also more 
expensive than the other two types of printers. 

 
♣What Is DPI? 
DPI (dots per inch) is a measure of how good a printer is. The more DPI, the better the 
print, and the easier it is to read. 
 
♣What Is A Modem? 
A modem is the communications hardware that allows your computer to send and receive 
information from other computers, over a telephone line.  
Most new computers come with internal modems. If you have an older computer you 
might have an external modem-a small box with a phone jack connected to your 
computer. You will need a modem (and a telephone line) to hook up to online services 
and the Internet. 
 
♣What Is Baud Rate? 
Baud rate is the number of times a modem's signal changes per second when transmitting 
data. It is how modem speed is measured. The bigger the number, the faster you can 
communicate. 
 
♣Is Modem Speed Important? 
Yes. Common speeds for modems are between 28,800 and 56,600 kilobytes per second 
(expressed as 28.8K and 56.6K). The existing telephone lines can only handle up to about 
56K.  
Cable TV companies are now providing access to the Internet through cable lines. All of 
this is an effort to give you faster access to information. 

 
♣What Is A DVD? 

• DVD stands for digital versatile disk.  
• DVD drives read DVDs.  
• A DVD holds about 5 gigabytes of information while a CD-ROM only holds 

about 600 megabytes.  
• A CD-ROM drive cannot read a DVD. However, DVD drives can read CD-

ROMs. 



♣Learning Start-up and Shut-down 
What is Booting Up?  
What Should You See On The Screen After The Start-Up?  
What is A Window?  
Recognizing the Parts of A Window  
What Are the Mouse Functions?  
What is the Start Button?  
How Do I Shut Down The PC?  
How Do I Re-Start The PC?  
 
♣What Is Booting Up? 
Booting up is a term for starting your personal computer. It initiates an automatic routine 
that clears the memory; loads the operating system, and prepares the computer for use.   
 
♣What Should You See On The Screen After The Start-Up?  
After the start-up, what you should see on the monitor is the Windows Desktop. It is the 
home base like the physical desk where the computer sits. Several tools to get you started 
are placed on the background area. These include a taskbar, icons, and a Start button. 
There will be variations from computer to computer on what the Desktop looks like.  
You will be able to customize the look of the Desktop to suit your artistic feelings! 
 
♣What Is A Window? 
A window is a framed region on your screen. It is a rectangular pane with information in 
it. Once you have selected an option from a menu, another window appears. We call that, 
opening a window. Most windows contain icons on which you can click to activate a 
program. 
 
♣Recognizing The Parts Of A Window 
The window is the rectangular area on the screen. Just like a real window, it can be 
opened and closed.  
Each window has a title bar at the top. It has the program name and the name of the 
document displayed in it.  
The menu bar is located directly under the title bar. It displays a list of command 
categories. In each category of commands, there are a number of choices.  
The toolbar is located under the menu bar. It displays a row of buttons for giving 
commands. 
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♣What Are The Mouse Functions?  
• Pointing: To point to something on the screen, move the mouse over the mouse 

pad until the pointer is in the pointed where you want it. The pointer will move in 
the same direction that you move the mouse. 

• Clicking: Single-clicking is probably the most used mouse function. To click 
something, point at it and quickly press and release the left mouse button. 
Generally when you see "click" it refers to a left-click. A right-click is sometimes 
used to find a shortcut menu. 

• Double-clicking: Point and quickly click the mouse button in rapid succession 
twice. Double-clicking is also used to initiate action. 

• Dragging: To drag, place the mouse pointer where you want to start the drag, 
press and hold down the mouse button, and then drag the mouse to the ending 
spot. When you have completed the drag, release the mouse button. Dragging 
allows you to select text, to move items, and to perform other tasks.  

 
♣What Is The Start Button?  
The Start button is the button that takes to different menus and programes in Windows. It 
is located on the taskbar. Clicking on the Start button brings up a single menu from which 
many menus and programs can be accessed.  

• To display the Start menu, click the Start button. You see the following sub-
menus (Windows 95 does not have Favorites or Log Off):  

• Sub-menu  -  What it does  
• Programs - View a list of your programs. 
• Favorites - Open your favorite files and Web pages.  
• Documents - Open a recently opened document.  
• Settings - Modify desktop or system settings.  
• Find - Search for files or folders.  
• Help - Get answers to your questions.  
• Run - Open items such as Web pages, programs, and other computer sources.  
• Log Off - Log off a Windows session.  
• Shut Down - Shut down or restart your computer.  
• The top of the Start Menu is where you will put shortcuts to your most frequently 

used programs. To put a program on your Start button, simply drag any icon from 
your Desktop onto the Start button. 

 
♣How Do I Shut Down The PC?  
It is important to use the correct shutdown procedure. You should never just shut off your 
computer.  
Before you shut down, always save the files you are working on. Always close Windows 
before shutting down your computer. This will help to protect your files from data 
corruption.  

continued…



♣Steps to Shut Down: 
• Click the Start button and select Shut Down.  
• Select the Shut Down option.  
• Click the OK or yes button.  
• You will see a screen that tells you it is safe to turn off your PC.  
• Turn off the power to your computer. Do not forget to turn off the monitor, too. 

 
♣How Do I Re-Start The PC?  
Your PC may experience a puzzling failure from time to time. Sometimes it may just 
freeze up, for no reason at all. Do Not Worry. You Did Not Do It! It is just the nature of 
computers to get confused on occasion. When this happens your mouse will not respond 
to clicks and the keyboard stops working. The machine do not responds. You will have to 
restart your computer.  
 
First, try the menu method. 

• Click the Start button and select the Shut Down button.  
• Select the Restart the Computer button.  
• Click the Yes button.  

 
If that did not work, try the alternate method.  

• Press these three keys at the same time: Ctrl Alt Delete  
• Select shutdown.  

 
Third, last method.  

• Use the reset button if your machine has one 
• Or  
• Turn off the power switch. 

 



♣Understanding Windows Basics 
What is the Windows Operating System?  
What is the Desktop?  
What is the Taskbar?  
What is an Icon?  
What is a Pointer?  
What is the Difference Between the (A :), (C :), and (D :) Drives?  
What is a File?  
What is an Extension?  
What is a Folder?  
 
♣What Is The Windows Operating System? 
Windows is the operating system that lets you give orders to your computer. The system 
acts on your commands. Newer versions of operating systems offer more advantages, so 
make sure you have the latest version.  
 
♣What Is The Desktop? 
The Desktop is the working area (background) of the Windows display on your 
computer.  
Look at your desk at home or work. It is the area where you do your paperwork. You pull 
a file, letter, or your checkbook from a drawer, do some work, and put it back when you 
are finished. The Desktop of the computer is where you will pull out your electronic files, 
write electronic letters or work in your computer-based checkbook.  
When you start your computer, you will see several screens go by before you arrive at the 
main Windows screen, which is the Desktop.  
 
♣What Is The Taskbar? 
The taskbar is the horizontal bar along the bottom of the Desktop. It has the Start button 
on the left. Task buttons appear on the taskbar to identify any open applications or 
programs currently being used. Displayed in small rectangles near the middle of the 
taskbar are the programs that are running. Near the right side, you will see the programs 
or tasks that start automatically when you start Windows. On the far right, you will see 
the time displayed.  
The taskbar allows you to start your navigation process through all of the computer files. 
If a program is minimized (meaning it does not appear on the screen, but is still being 
used), clicking on it from the taskbar brings it back onscreen. You can easily switch to a 
different window by clicking its button on the taskbar. 
 
♣What Is An Icon? 
An icon is a little picture that represents a program, command, or a file. For instance, the 
My Computer icon looks like a small computer.  
Icons that have a small white arrow in the lower left corner are Shortcuts. The arrow 
indicates that the icon is a shortcut that points to a program, folder, or other item. A 
shortcut is a quick way to open a program or file. 



 
♣What Is A Pointer? 
A pointer is the arrow you use to choose things on screen. Since the Shortcut is simply a 
pointer to a specific program or file, you can delete the shortcut or remove it from the 
Desktop without actually deleting the program or file. 
 
♣What Is The Difference Between The (A :), (C :), and (D :) Drives? 

• The (A :) drive is the floppy drive. Older computers used to have two floppy 
drives, and the second one was the (B :) drive.  

• The (C :) drive is the hard disk drive. This drive is non-removable.  
• The (D :) drive is usually the CD-ROM drive. Sometimes it is the (E :) drive. 

 
♣What Is A File? 
A file is a collection of information, with a unique name, stored in your computer or on a 
removable disk.  
Your checking account could be in one file. A single letter could be in another file or a 
collection of letters could be in one file. 
 
♣What Is An Extension? 
The last three letters (suffix) of a file name designate an extension. An extension 
identifies the format of the file. It is preceded by a period.  
Every file is in a specific format. There are many different formats. By naming a file with 
an extension, you tell the computer which format the file is in. That way the computer 
knows what format to use each time you want to work with that file. 
 
♣What Is A Folder? 
Folders are special files that can hold multiple documents. They allow you to organize 
information. Folders can hold both files and other folders (subfolders).  
For example, you could put all of your letters to Aunt Mary in a folder with her name on 
it; or you could put the Aunt Mary folder into the General Correspondence folder, that 
holds many other files and folders. 

 



♣Learning Basic Skills 
What are the Basic Skills? 
Opening a Window  
Resizing a Window  
Moving a Window  
Too Many Open Windows?  
What Is a Scrollbar?  
What Is a Menu?  
What Is a Menu Bar?  
Using Menus and Sub-Menus  
What Is a Shortcut Menu?  
What Are The Key Functions?  
How Do I Close a Program?  
 
♣What are Basic Skills? 
Basic skills are used repeatedly in every program. They include selecting text, cutting and 
pasting text, copying and deleting text. You will also need to know how to open a 
document, save a document, and print your work.  
Some of the common skills that you’ll use daily are: 

• Selecting text: Click at the beginning of the text you want to select. Hold down 
the mouse button and drag across the text. Release the mouse button and the text 
will appear highlighted.  

• Cutting, copying and pasting: These commands are found under the Edit menu. 
The Cut command allows you to remove text from your document and use it 
elsewhere. The Copy command lets you duplicate a section of your document, for 
use elsewhere, without removing it from the original spot. After you have Cut or 
Copied your selection, move the cursor to the place in the document where you 
want the section to appear. Then select the Paste option.  

• Deleting text: Select the text you want to delete. Press the Delete key. This is 
different from Cut, as this text is not stored in the computer's memory for your 
use.  

• Saving a document: One of the most important precautions you can take while 
working is to save your work frequently. On the File menu of the program you are 
working in, click Save As. The Save As window appears. In the File Name text 
box there is a blinking cursor or highlighted text. Type in the name you want the 
file to be called. Click on Save. As you continue working on the document, you 
need only to choose the Save command from the File menu.  

• Printing your work: From the File menu, choose Print. After making sure all of 
the options are set as you like them, click on OK. 
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♣Opening A Window 
There are two types of windows, and both types have the same set of controls.  

• To open a window displaying the contents of a disk or folder, double-click on the 
icon. The window is displayed on the Desktop.  

• To open a window displaying a program, start the program. The program is 
started and displayed in a program window. If you are working in a program, you 
can have two windows open: the program window and the document window. 
Each window has its own set of controls. Confusing? Don't worry. With a little 
practice, you will be a pro at this. 

 
♣Resizing A Window 
You may want to change the size of the window to make it easier to read. There are 
several ways to resize a window.  

• Put the pointer on any of the window's borders, but not on the title bar. The mouse 
pointer turns into a two-headed arrow. Drag the border to change the size of the 
window.  

• Use the Minimize and Maximize buttons that are located in the upper right corner 
of every window. If you click on the Minimize button, the window "closes". You 
will notice how the program button is still on the taskbar. This is different from 
actually exiting the program that you can do by clicking on the "x" button. 

• Instead of quitting the program entirely, minimizing closes only the window of 
the program. The title of the program you minimized now appears as a button on 
the taskbar. To maximize or open the window again, click on the button. 

 
♣Moving A Window 
You may want to rearrange where a window is located. Follow these steps to move a 
window:  

• Point to the window's title bar.  
• Drag the title bar to the location you want and release the mouse button. 

 
♣Too Many Open Windows? 
There are some commands you can use to "clean up" the window clutter on your 
Desktop.  

• Right-click on the mouse anywhere on the taskbar. A menu appears.  
• Select Cascade. The Cascade command displays the windows so that the title bars 

of each window appear. 
• Click on the title bar to bring its window to the front of each stack.  
• Tile horizontally stacks each window in horizontal panes and Tile Vertically 

stacks each window in vertical panes. 
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♣What Is A Scrollbar? 
A scrollbar is a gray rectangle with small black arrows on both ends. It lets you select the 
portion of the window you want to see. It is on the right side of a window for vertical 
scrolling and on the bottom for horizontal scrolling. When a document is so big it cannot 
completely be displayed on the monitor, a scroll bar appears so you can see all of its 
contents by moving the document up and down the screen, or right and left.  
The Page Up key scrolls the document up and the Page Down key scrolls it down one full 
page rather than one line at a time. By clicking the up/down scroll arrow one time, you 
will move the document one line at a time. By clicking on a blank spot above or below 
the scroll indicator, you will move the document up/down one page. You can 
continuously scroll by depressing the mouse button steadily instead of by just clicking it. 
 
♣What Is A Menu? 
A menu is a list of commands displayed on your screen, which allows you to perform 
tasks. When you click on any of the words in the menu, a list of choices drops down. Just 
as you would select your choices from a restaurant menu, you select the choices of what 
to do on your computer 
 
♣What Is A Menu Bar 
A menu bar is an onscreen display that lists available categories of commands. It is 
usually located at the top of the program window. To choose a category or command, just 
click on it. 
 
♣Using Menus And Sub-Menus 
It is as simple as this:  

• On the menu bar, choose the category of the command that you want. The menu 
opens.  

• Click on the command you want. Voila!  
If a sub-menu opens, it is just giving you more options of how to accomplish your task at 
hand. 
 
♣What Is A Shortcut Menu? 
A shortcut menu is a hidden menu that can be opened at any time. Almost every object on 
your Desktop has one. If you right-click on the item, the shortcut menu will appear. 
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♣What Are The Key Functions? 
• Fl-F12. These are programmable keys called function keys. They provide special 

functions depending on the software you are using.  
• Esc. The escape key cancels a command or an operation.  
• Numeric Keypad. A calculator-style set of keys for entering numbers.  
• NumLock. The Number Lock key switches the right-hand keypad between typing 

numbers and being used as cursor keys.  
• Arrow Keys. The keys that move the cursor onscreen. The arrow keys move the 

cursor in the direction indicated by the arrow on each key-one character left or 
right or one line up or down.  

• Page Up (Pgup) and Page Down (PgDn). These keys move the cursor to the 
preceding screen (PgUp) or the next screen (PgDn).  

• Ctrl. The control key pressed in combination with other keys, acts as a shortcut to 
execute commands and to select commands from the drop down menus.  

• Delete (Del). This key deletes the current character. 
 
♣How Do I Close A Program? 
Always remember to close a program when you are finished working in it. Otherwise, it 
will be taking up memory that other programs may need.  

• To close a program:  
• Save your work.  
• Click the Close (x) button in the title bar of the window of the program.  
• If you have not saved your work, the program asks you if you want to. Click Yes 

to save it, click No to lose it.  
• The program window disappears. Alternate method if the close button does not 

work:  
• Go to File.  
• Save your work.  
• Click Close from the drop down menu. 
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